Blackboard Collaborate Classroom in D2L Brightspace – Daylight Experience

Presenters
# Table of Contents

Introduction .......................................................................................................................... 5  
System Requirements ........................................................................................................... 5  
Learning Objectives ............................................................................................................ 5  
Creating a Collaborate Classroom Link in D2L Brightspace ............................................. 6  
Creating a Blackboard Collaborate Session ....................................................................... 8  
Starting your Collaborate Session ....................................................................................... 12  
The Blackboard Collaborate Classroom Interface ............................................................... 17  
The Audio & Video Panel ..................................................................................................... 18  
  The Audio Setup Wizard .................................................................................................... 18  
  Setup Video ......................................................................................................................... 23  
    The Talk Button ................................................................................................................ 25  
    Simultaneous Talkers ....................................................................................................... 25  
    The Video Button ............................................................................................................ 26  
    Setting the Video Follow ................................................................................................. 26  
    Using the Telephone for Audio ....................................................................................... 27  
  The Whiteboard .................................................................................................................. 28  
    Whiteboard Tools ............................................................................................................ 29  
    Loading Content to the Whiteboard ............................................................................. 29  
    File Sharing ...................................................................................................................... 31  
  Application Sharing ............................................................................................................ 33  
  Web Tour ............................................................................................................................. 35  
The Participants Panel .......................................................................................................... 36  
  Adding Feedback ............................................................................................................... 36  
  Setting Status to Away ...................................................................................................... 37  
  Raising and Lowering Hands ......................................................................................... 38
Introduction

Blackboard Collaborate is an interactive communication tool that integrates into D2L Brightspace to provide a greatly enhanced online learning experience for students and instructors. With Blackboard Collaborate, you can have live two-way interaction with students, display and share your desktop applications, and deliver learning content while you discuss it with session Participants. While most internet browsers will work with Collaborate, this documentation was created using Mozilla Firefox version 51.0.1.

System Requirements

Windows
- Windows XP, Windows Vista, Windows 7, Windows 8, or Windows 10
- Speakers, microphone, and/or headset
- An Internet connection
- Internet Explorer 9 or above, Mozilla Firefox, Google Chrome

Mac OS X
- Mac OS X 10.6 or higher
- Speakers, microphone, and/or headset
- An Internet connection
- Safari, Mozilla Firefox, Google Chrome

Other Requirements
- Pop-up blocker for your web browser must be disabled.
- You must allow Collaborate firewall access if prompted.
- You must allow the Java session when prompted.

Mobile Devices
It is not recommended that presenters use a mobile device when hosting a Collaborate session. Additional information on system requirements can be found on the Collaborate Support site at: http://www.blackboard.com/support/index.html.

Learning Objectives

After completing the instructions in this booklet, you will be able to:
- Create a Collaborate Session in D2L Brightspace.
- Perform the first time setup, and configure audio and video.
- Understand the Blackboard Collaborate interface.
- Be able to create and access any Blackboard Collaborate sessions that have been archived.
- Utilize the presenter tools within Collaborate.
Creating a Collaborate Classroom Link in D2L Brightspace

The following explains how to create a link to the Blackboard Collaborate Tool using the Content tool in D2L Brightspace:

1. Log in to your D2L Brightspace course and go to Content.

![Figure 1 - Click Content](image1)

2. Create a new module or select an existing module.
3. Click the drop-down next to Existing Activities (See Figure 2).
4. Click External Learning Tools from the drop-down menu (See Figure 2).

![Figure 2 - External Learning Tools](image2)

5. Click the Blackboard Collaborate Link.

![Figure 3 - Blackboard Collaborate](image3)
6. A link to the Blackboard Collaborate tool will be added to your content.
7. To have the Blackboard Room launch in a new window for your students, click the drop-down menu next to the Blackboard Collaborate link (See Figure 4).
8. Click Edit Properties In-place (See Figure 4).

![Figure 4 - Edit Properties In-place](image)

9. Mark the Open as External Resource checkbox to have your classroom launch in a new window when opened.

![Figure 5 - Open in New Window](image)
Creating a Blackboard Collaborate Session

Upon creating a Collaborate link, you have the ability to create a session for your students. Sessions are web conferences that enable you to engage Participants in a live web environment. You must create at least one session in order to launch a web conference with your Participants. The following explains how to create a Blackboard Collaborate session in D2L Brightspace.

1. In your Module, click the **Blackboard Collaborate** content topic.

2. In the **Collaborate window**, click the **Create Session** link.

   ![Create Session](image)

   **Figure 6 – Create Session**

3. Enter the Name of your session in the **Session Name** field.

   ![Session Name](image)

   **Figure 7 - Session Name**

4. To select a **Start Date** and **Time**, click the **Calendar Icon**.

   ![Calendar Icon](image)

   **Figure 8 - The Calendar Icon**

5. Click the **Start Date** of your Collaborate Session.

   ![Click on the Start Date](image)

   **Figure 9 - Click on the Start Date**
6. Select the **Start Time** of your session.

![Figure 10 - Start Time](image)

7. Upon setting the start time, click off from the **Calendar tool** to be taken back to the *Create New Session* window.

8. Select the **End Time** of your session.
   **Note:** Session End Times are optional.

![Figure 11 - End Time](image)

9. If you wish to enable *Early Entry* into your session, select an **Early Entry** time.
   **Note:** If Early Entry is not enabled, Participants cannot enter the session until the set start time.

![Figure 12 - Early Entry Time](image)
10. For additional options, click the **Options** tab. In this tab, you will be able to set *Participant permissions*, set the *Recording Modes*, set the number of *Simultaneous Talkers*, whether *Private chat messages* are *supervised*, as well as additional options. The following explains these additional options in detail.

![Session Options](image)

**Figure 13 – Session Options**

- **Grant Participants full default permissions**: Session Participants will be granted the default permissions. This includes access to the whiteboard, the ability to chat, the ability to speak during the presentation, and the ability to broadcast video (See Figure 13).

- **Hide attendee names in recordings**: Names of the Participants will be hidden during recordings of the session (See Figure 13).

- **Everyone is a Moderator**: With this option set, all Participants will have Moderator permissions (See Figure 13).

- **Allow in-session invitations**: Invitations to Participants can be sent while the session is ongoing (See Figure 13).
e. **Enable Private chat messages to be supervised:** Private chat messages amongst Participants will be viewable by Moderators (See Figure 13).

f. **Participants raise hand upon entering the session:** When a Participant enters the session, he or she will automatically raise his/her hand. This will inform the Moderator that a new Participant has entered the session (See Figure 13).

g. **Recording Mode:** Sets whether or not the Moderator can manually record the session, have the session be automatically recorded, or if the Moderator can disable the recording (See Figure 13).

h. **Maximum Simultaneous Talkers:** Sets the number of maximum simultaneous speakers in the session. You can up to have six simultaneous speakers at once (See Figure 13).

i. **Maximum Simultaneous Cameras:** Sets the number of maximum simultaneous cameras. You can have up to six cameras (See Figure 13).

11. When you are ready to create your session, click on **Create Session**.
12. Upon saving you will be taken to a window detailing the session information. The following explains the layout of the session information window:

![Session Information Window]

**Figure 15 - Session Information**

- **Participant Dial In:** Provides Participants the phone number for teleconferencing (See Figure 15).
- **Moderator Dial In:** Provides Moderators a dial in for teleconferencing (See Figure 15).
- **Guest Link:** Provides guests a link to join the session (See Figure 15).
- **Start:** Provides information on the Start Time for your session (See Figure 15).
- **End:** Provides information on the End Time of your session (if specified) (See Figure 15).
- **Early Entry:** Displays the Early Entry time (if specified) (See Figure 15).
- **Edit your session using the Edit Session button.** (See Figure 15).
- **Delete your session using the Delete button.** (See Figure 15).
- **Join your session using the Join button.** If your session start date is sometime in the future, you will be unable to click on the Join button (See Figure 15).

**Starting your Collaborate Session**

The following explains how to start your Blackboard Collaborate Session:

1. Before starting, plug in your headset, microphone, and an optional webcam.
2. Navigate to your Content within D2L Brightspace.
3. Navigate to the module containing your Blackboard Collaborate link.
4. Click the Blackboard Collaborate topic.

5. In the Blackboard Collaborate Web Conferencing page, click the session that you wish to launch.

6. Click Join.

7. The Launching Blackboard Collaborate page will open. Here you will be prompted to open the meeting.jnlp file.
8. Select **Open with Java (TM) Web Start Launcher (default)** and click **OK**.

![Figure 20 - Open Java Web Start File](image)

**Note:** Depending on your web browser’s download settings, it may save the file to your computer. If so, just go to the folder your browser uses to store downloads and open the meeting.jnlp file.

9. A security warning will appear. Click **Run**.

![Figure 21 - Run Application](image)
**Note:** If you receive a notification that your firewall is blocking the application, allow it access to run.

![Figure 22 - Allow Firewall Access](image)

10. The *Blackboard Collaborate Participant Agreement* will appear the first time you access a session from your computer. Click **Accept**.

![Figure 23 - Participant Agreement](image)

11. The *Select Connection Speed* window will appear. Select your **connection speed** from the dropdown menu.

![Figure 24 - Select Connection Speed](image)
Note: Check the Don’t show this dialog again to skip this step next time you log in from the same computer.

12. Click Ok.

13. The Blackboard Collaborate session will open and the Blackboard Collaborate Classroom will appear.

![Figure 25 - The Blackboard Collaborate Classroom](image-url)
The Blackboard Collaborate Classroom Interface

Upon accessing Blackboard Collaborate, you will be taken to your Classroom. The Classroom interface is as follows:

![Blackboard Collaborate Classroom Interface](image)

**Content Area**

The Content Area is the main focus of a Blackboard Collaborate Classroom session. Almost all content will appear in the Content Area.

**Audio & Video Panel**

The Audio & Video panel enables users to participate in conversations using microphones, headsets, and web cameras. The Moderator can enable up to 6 simultaneous talkers in a session.

**Participants Panel**

The Participants Panel lists all students who are currently logged in to the Live Classroom session, as well as the instructor.

**The Chat Panel**

The Chat Panel is where you can communicate via text chat with students.
**Whiteboard Tools**  
The main presentation area where you are able to add objects, text, and clip art into the Content Area.

**Content Navigation**  
The Content Navigation area allows you to navigate amongst content being shared during your Collaborate session.

**The Audio & Video Panel**

![Audio & Video Panel](image)

**The Audio Setup Wizard**  
Before your first Blackboard Collaborate session begins, you will want to access the session to run the Audio Setup Wizard. The Audio Setup Wizard is a quick wizard that will allow you to set your microphone and preferred speakers.

1. Enter your Blackboard Collaborate session and click the **Audio Setup Wizard** button in the **Audio & Video Pane**.
2. The Select Audio Output Device window will appear. Select the Audio Device that you want to use to listen to the web conference.

3. Click OK.

4. The Speaker Setup window will appear. Click Play.
5. The Audio Setup Wizard will play a short message to test your speakers. Once the message is finished, the Audio Setup Wizard will ask if you were able to hear sound.

![Figure 31 - Speaker Setup Confirmation](image)

6. Click **Yes** if you could hear the message. If not, click **No** and the Audio Setup Wizard will give you additional steps to troubleshoot your audio problems and an option to try again.

7. The Select Audio Input Device window will appear. Select the Audio Device that you want to use to talk during the web conference.

![Figure 32 - Select Audio Input Device](image)

8. Click **OK**.
9. The *Microphone Setup* window will appear with additional instructions to follow while setting up.
10. Click the **Record** button to begin testing your selected microphone.

![Microphone Setup](image)

**Figure 33 - Microphone Setup**

11. Speak into your microphone and use the volume slider to adjust the recording volume.
12. Click **Stop** to end recording.
13. The *Microphone Playback* window will appear. Click **Play** to listen to your test recording.

![Microphone Playback](image)

**Figure 34 - Microphone Playback**
14. The Audio Setup Wizard will play your test recording. Once playback has finished, the Audio Setup Confirmation window will appear and will ask if you are comfortable with the recording volume.

![Audio Setup Wizard](image1)

**Figure 35 - Microphone Setup Confirmation**

15. Click **Yes** if the recording volume is ok. If not, click **No** and the Audio Setup Wizard will give you additional steps to troubleshoot your audio problems as well as an option to try again.

16. Audio setup is now complete. Click **OK** to return to your active session.

![Audio Setup Wizard](image2)

**Figure 36 - Audio Setup Complete**

**Note:** You can run the Audio Setup Wizard at any time by clicking on the Audio Setup Wizard button. It is recommended that you run the Audio Setup Wizard the first time you access a Blackboard Collaborate session from a different computer.

**Setup Video**

If you would like to transmit video during the Collaborate session, and have already installed a webcam, you can set it up in the options under the Audio & Video Panel.
1. In the **Audio & Video Panel**, click the options dropdown menu.

   ![Figure 37 - Click Options](image)

2. Click **Camera Settings** in the dropdown menu.

   ![Figure 38 - Select Camera Settings](image)

3. The **Preferences/Camera Settings** window will appear. Select your **webcam** from the drop-down menu.

   ![Figure 39 - Select Webcam](image)

4. Click **OK**. You will be returned to your active session.

5. To test your video, click the **Preview Video** button. This video will not be transmitted to other Participants in your session.

6. To transmit video, click **Video**.
The Talk Button
To talk during your session, press the Talk button. The button will display a blue microphone icon, indicating that you are transmitting audio. Press Talk again to stop transmitting audio.

![Talk Button](image1)

Figure 40 - The Talk button

To adjust Microphone levels, use the adjustable lever located above the Talk button.

![Microphone Adjustment](image2)

Figure 41 – Microphone Adjustment

To adjust the speaker levels for your speakers, use the adjustable lever located above the Video button.

![Volume Adjustment](image3)

Figure 42 - Volume Adjustment

Simultaneous Talkers
As a Moderator, you can enable up to 6 simultaneous talkers in a session. Participants should use headsets with microphones or an echo-canceling audio device to avoid unwanted echoing of the audio during the session. To enable your preferred number of simultaneous talkers:

1. Click on the Tools dropdown, located at the top of the Audio & Video Panel.

![Tools Icon](image4)

Figure 43 - The Tools Icon

2. In the dropdown, click on Maximum Simultaneous Talkers...

![Maximum Simultaneous Talkers](image5)

Figure 44 - Maximum Simultaneous Talkers...

3. In the window, select your preferred number of simultaneous talkers and click OK.
The Video Button
To turn on your camera and transmit video, press the Video button. After turning on the video, a red camera icon will be displayed. This will indicate that you are transmitting video. Press the Video button again to turn off your camera.

If you would like to preview your video before you begin broadcasting, click the Preview video button before you click the video button. The preview appears in the lower right-hand corner of the Video window.

Setting the Video Follow
You may also set whom the video camera follows within Collaborate. For example, you may set the camera in the Audio & Video panel to follow whoever is speaking, or to follow just the Moderator. To do so:

1. Click on the Tools menu at the top of your Collaborate window.

2. Click on the Video option within the Tools menu.
3. To set the camera to follow the Moderator, select the **Make Video Follow Moderator Focus** option.

![Figure 49 - Make Video Follow Moderator Focus](image)

4. To set the camera to follow the person who is speaking, select the **Make Video Follow Speaker** option.

![Figure 50 - Make Video Follow Speaker](image)

**Using the Telephone for Audio**

The **Telephone Simulcast** provides a backup option for users who do not have a microphone or are experiencing technical difficulties. Using the **Telephone Simulcast**, you will be provided a Moderator and Participant dial-in number that can then be provided to session Participants in the event that they must use a phone to participate in the simulcast.

To access the Simulcast:

1. Click the **Phone** icon. A telephone number and PIN will appear.

![Figure 51 - The Phone icon](image)

2. Dial the telephone number provided and enter the PIN when verbally prompted.

![Figure 52 - Telephone Information](image)

3. Click **Ok**.
The Whiteboard

The Whiteboard is the primary area for displaying content in a session. It is the most commonly used mode of the Collaborate Web Conference Content area. It is used for giving presentations (e.g., PowerPoint slides) as well as collaboration between session attendees. Like the other content modes, Application Sharing and Web Tour, the Whiteboard can be accessed through the Collaboration toolbar.

The Whiteboard has the following components:

1. Collaboration Tools (Whiteboard, Application Sharing, Web Tour)
2. Information Menu
3. Zoom Level
4. Current Page/Slide Name
5. Whiteboard Tools
6. Text Formatting Tools
7. Whiteboard Page
Whiteboard Tools

The Whiteboard Tools contain drawing and text tools that can be used to add notes, comments, or add and manipulate pictures/objects on the Whiteboard Page. The following tools can be selected from the Whiteboard Toolbar on the left side of the Whiteboard Page (see Figure 54).

Figure 54 - Whiteboard Tools

1. **Selector Tool**: Select objects on the Whiteboard;
2. **Pointer Tools**: Draw attention to something on the Whiteboard;
3. **Pencil/Highlighter**: Draw or Highlight;
4. **Text Editor Tool**: Insert text;
5. **Filled Shape Tool**: Insert a filled shape;
6. **Empty Shape Tool**: Insert an empty shape;
7. **Line Tool**: Draw a line;
8. **Screen Capture Tool**: Take a picture of your screen; and
9. **Clip Art Tool**: Insert images

Loading Content to the Whiteboard

With the Whiteboard, you have the ability to upload content to Collaborate to share with your session Participants. For example, you may upload:

- Whiteboard files
- PowerPoint files
- OpenOffice.org files
- Image files

To upload PowerPoint files to the Collaborate Whiteboard:

1. Click on the **Load Content** button, located above the Whiteboard.

Figure 55 - Load Content
2. In the *Load Content* window, navigate to and select the PowerPoint file that you wish to share with your session.

![Selecting a PowerPoint File](image)

Figure 56 - Selecting a PowerPoint File

3. Click **Open**.
4. The PowerPoint Conversion process will begin.

![Converting PowerPoint Slides](image)

Figure 57 - Converting PowerPoint Slides

5. When the PowerPoint conversion is completed, you will see your PowerPoint file open within Collaborate. By default, the **Page Explorer** will also open. The Page Explorer allows you to easily navigate through and re-order your slides.

![Page Explorer](image)

Figure 58 - Page Explorer
a. To navigate through the PowerPoint File using the **Page Explorer**, use the left and right arrows, located at the top of the Page Explorer window.

![Page Explorer](image)

*Figure 59 - PowerPoint Navigation*

b. To reorder your PowerPoint Slides, click on the slide that you wish to reorder and from there, drag the slide to your preferred location within the presentation.

c. To close the **Page Explorer**, click on the **Close Button** at the top of the Page Explorer window.

**Note:** When you close the Page Explorer, the PowerPoint navigation buttons will be moved to the top of the Whiteboard.

**File Sharing**
With Collaborate, you may also share content with your Participants. With File Transfer, you may upload files such as Microsoft Word and Excel Documents to Blackboard Collaborate, which will in turn be sent to your Participants. The following explains how to use the File Sharing feature in Collaborate.

1. Click on **File**.

![File Menu](image)

*Figure 60 - Click on File*

2. Click on **Open**

![Open Menu](image)

*Figure 61 - Click Open*

3. Select **File for Transfer**
4. Navigate to and select the file that you wish to share with your Participants.

5. Click **Open**.

6. The *File Transfer Library* window will appear. This will indicate the files that have been shared with Participants as well as the upload status of the file that you have selected.
Application Sharing

Application Sharing allows Moderators to share their programs or desktops with Participants in the session. Anything shared will appear on the Whiteboard Page.

1. Open the application that you wish to share and leave that window open.
2. In Collaborate, click on the Application Sharing button within the Collaboration Tools.

3. A window will appear showing your available applications to be shared. Select an application from the list.
4. Click **Share**.

![Share Application](image)

**Figure 68 - Share Application**

5. A *Hosting Notification* window will display. Click **OK**.

![Hosting Notification](image)

**Figure 69 - Hosting Notification**

6. Collaborate will now share your application. The area contained within the yellow border is what is transmitted to Participants in your session.

![Application Sharing Window](image)

**Figure 70 - Application Sharing Window**

7. To pause application sharing, click the **pause** icon in the upper-left corner of your shared application.

![Pause Application Sharing](image)

**Figure 71 - Pause Application Sharing**
**Note:** When application sharing is paused, session Participants will still see the application, but not the current actions you may be taking.

8. To stop application sharing, click the **stop** icon in the upper-left corner of your shared application.

![Stop Application Sharing](image)

**Figure 72 – Stop Application Sharing**

### Web Tour

The Web Tour tool allows Presenters to share web pages with Participants in the session. Anything shared will appear on the Whiteboard Page. The following explains how to utilize the Web Tour feature.

1. Click on the **Web Tour** button within the **Collaboration Tools**.

   ![Web Tour](image)

   **Figure 73 - Web Tour**

2. In the **address field**, type the web address you wish to visit and press **Enter** on your keyboard.

   ![Enter Web Address](image)

   **Figure 74 - Enter Web Address**

   **Note:** Make sure the **Follow Me** box is checked so your web view will be shared with session Participants.

3. The web page will open within the **Whiteboard** area of your session. Use the Back/Forward buttons next to the **Address Field** to navigate backward/forward through your viewing history.

   ![Navigation buttons](image)

   **Figure 75 – Navigation buttons**

4. To stop the **Web Tour**, click on the **Whiteboard** button within the **Collaboration Tools**.

Page 35 of 47
The Participants Panel

The Participant Panel lists all the presenters and Participants who are currently in the room. By default, Moderators are displayed in bold at the top of the list. Unless you chose to give students the same rights as the instructor when you created the room, you will be the only presenter listed. Next to the list of Moderators and Participants are additional options:

A. **Expand/Collapse Tool**: This tool allows you to expand/collapse the Participant’s panel.

![Figure 77 - Expand/Collapse](image)

B. **Feedback**: Allows the Moderator or Participant to select feedback options. These options express common reactions to a presentation.

C. **Step Away Button**: The Step Away feature enables you to indicate to others in the session that you are temporarily unavailable. While you are still connected to the session and can hear/see what is going on, others just won’t expect you to be available to interact.

D. **Raise Hand Button**: During the presentation, Moderators and Participants can raise their hands at any time during the session. The Participants list will indicate who has raised their hands as well as the order in which they have raised their hand.

E. **Polling Response**: This tool allows you to conduct polls of session attendees.

Adding Feedback

Moderators and Participants can select feedback to express a reaction to a presentation. The feedback will appear under your login name for a short time and then disappear.

1. On the Participants Panel, mouse over the Feedback Menu button.
2. The *Feedback Menu* dropdown will appear. Click on a *feedback icon*.

3. Your selection will display under your session name and disappear after a few seconds.

### Setting Status to Away

You can indicate to others in your current session that you are temporary unavailable, while still being able to see and hear what is going on.

1. On the *Participants Panel*, click the *Step Away* button.
2. Your status will display as *Away* under your session name.

3. To clear your away status, click the **Step Away** button again.

**Raising and Lowering Hands**
Participants and Moderators can raise and lower their hands at any time during the session. When a Participant raises their hand, their name will move to the top of the Participant list under the Moderator with a number to show the order their hand was raised.
1. On the Participants Panel, click the Raise Hand button.

   **Note:** A raised hand icon will appear over your account picture, with a number representing the order your hand was raised in.

2. To reset raised hands, on tools.
3. Click on Interaction
4. Click on Lower All Hands

**Permissions**

As a Moderator, you have access to all permissions automatically. Default global permissions given to Participants are established when the session is initially created and configured. Typically, Participants can use all the Blackboard Collaborate web conferencing features except Application Sharing, Web
Tour, Content Uploading and Closed Captioning. If permissions are turned off during session configuration, Participants will only be able to use the buttons in the toolbar, view profiles and send Moderators private Chat Messages. The following shows the various icons associated with each permission:

A. Audio Permission 🎧: The Audio permission allows Participants to talk in the session. If the permission is not granted, they can still listen to other Participants in the session.

B. Video Permission 🎥: Allows Participants to transmit video in the session. In the event that the permission is not granted, users can still preview their own video as well as view the video transmissions of others.

C. Chat Permission 📩: Allows Participants to enter chat messages in the session. If the permission is not granted, they can still send private chat messages to Moderators as well as read the Chat messages of others.

D. Whiteboard Permission ✒️: The Whiteboard permission allows Participants to use the drawing tools in the Whiteboard.

E. Application Sharing Permission ✉️: Allows Participants to host an Application Sharing session.

F. Web Tour Permission 🌍: The Web Tour permission allows Participants to host Web Tours and Web Pushes.

G. Closed-Captioning Permission 📚: Allows Participants to enter text into the Closed-Captioning window.

Understanding the Activity Indicators
There are a number of icons that can display next to a user’s name in the Participants Panel that will indicate their current activity or status. For instance, if the Microphone activity indicator is blue, this indicates that the Participant has turned on his/her microphone. The following chart indicates the different activity indicators there are in Blackboard Collaborate:

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>User has turned on their microphone. (Using VoIP for Audio)</td>
</tr>
<tr>
<td>📲</td>
<td>The user has connected to the session via telephone.</td>
</tr>
<tr>
<td>Activity Indicator</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>📞</td>
<td>User is using Telephony mode for audio communications. (Using the phone for Audio.)</td>
</tr>
<tr>
<td>📲</td>
<td>User is running the Audio Setup Wizard.</td>
</tr>
<tr>
<td>📸</td>
<td>User is transmitting Video.</td>
</tr>
<tr>
<td>📩</td>
<td>User is entering a Chat message.</td>
</tr>
<tr>
<td>📬</td>
<td>Chat permission is set globally to &quot;on&quot; but Moderator has revoked Chat permission from this user.</td>
</tr>
<tr>
<td>📫</td>
<td>Chat permission is set globally to &quot;off&quot; but Moderator has granted Chat permission to this user.</td>
</tr>
<tr>
<td>🖋️</td>
<td>User is entering content into the Whiteboard with one of the Whiteboard drawing tools or, if the user is a Moderator, may be loading content into the Whiteboard.</td>
</tr>
<tr>
<td>📊</td>
<td>User is hosting an Application Sharing session.</td>
</tr>
<tr>
<td>🌐</td>
<td>User is conducting a Web Tour or Web Push.</td>
</tr>
<tr>
<td>⏳️</td>
<td>User has stepped away from the session.</td>
</tr>
</tbody>
</table>

**Figure 85 - Activity Indicators**

**Note:** These icons will automatically display when you perform the corresponding action.

**The Chat Panel**

The Chat Panel allows you to exchange messages with others during the session. You may use the Chat Panel to send a message to everyone in the session, to selected Participants, or to a single Participant or Moderator in the session. Depending on the configuration of the session, you as the Moderator may be able to monitor all messages that are sent by Participants, including private messages. The Chat Panel layout is as follows:

**Figure 86 - The Chat Panel**
1. Expand/Collapse  
2. Text Box (Messaging)  
3. Conversation Tabs  
4. Options menu  
5. Conversation Pane  
6. Emoticon Menu

Types of Chats
There are four methods of chat messaging within Blackboard Collaborate:

- **Public** messages to everyone in the current room
- **Private** messages to one or more selected individuals
- **Private** messages to other Moderators
- **Public** announcements to everyone or in selected rooms

Sending Public Messages
To send a public message in Blackboard Collaborate:

1. Place your cursor in the Chat Text Box.
2. Type your message in the text area.
3. Press the **ENTER** key when you have completed your message.

Sending Private Messages to One or More Individuals
You can initiate a private message to one or more individuals by one of the following ways:

- **If sending to one person**: Double-click on the name of the person in the Participants list. Alternatively, you may select the person’s name in the Participant’s list and then select **Send a Private Chat** from their Participant Option menu

- **If sending to multiple people**: Select the names of the people in the Participants list (using the standard Shift or Control methods), right-click (Control-click on Mac) on the highlighted names to open the Participants Option menu and then select **Send a Private Chat**.

After initiating your message, enter your text into the Chat Text Box and press the **ENTER** key.

Sending Private Messages to Other Moderators
You can initiate a private message with other Moderators as well. To do so, you must enter the Moderators chat by clicking on the **Moderators Tab**. From there, click on the name of the Moderator you wish to chat with and compose your message.

Sending Public Announcements
You may wish to send a message as an announcement in the event that you want to ensure your message will stand out to all message recipients. In this case, you can send announcements to the room you are in, to all rooms, or to Moderators only.

**Send an Announcement to the Entire Room**

1. Click on the **Room** tab, located at the bottom of the Chat Panel.

   ![Room tab](image)

   **Figure 87 - The Room tab**

2. Click on the **Chat Panel Options** dropdown, located at the top of the chat panel.

   ![Chat Panel Options](image)

   **Figure 88 - Chat Panel Options**

3. Click on **Send Announcement**.

   ![Send Announcement](image)

   **Figure 89 - Send Announcement**

4. Type the Announcement that you wish to send.
5. When you have completed your announcement, click on **Send**.

**Send an Announcement to other Moderators**

1. Click on the **Moderators** tab, located at the bottom of the Chat Panel.

   ![Moderators tab](image)

   **Figure 90 - The Moderators tab**

2. Click on the **Chat Panel Options** dropdown, located at the top of the chat panel.

   ![Chat Panel Options](image)

   **Figure 91 - Chat Panel Options**

3. Click on **Send Announcement**.

   ![Send Announcement](image)

   **Figure 92 - Send Announcement**

4. Type the Announcement that you wish to send.
5. When you have completed your announcement, click on **Send**.

**Recording Collaborate Sessions**

Blackboard Collaborate gives you the ability to start and stop a recording at any time within your session. To start a recording:

1. Press the **Record** button, located above the Collaborate Whiteboard.

![Figure 93 - The Record Button](image)

2. At the **Confirm Recorder Start** prompt, press **OK**.

![Figure 94 - Press OK](image)

3. You will hear a message from Collaborate indicating that the recording has begun. A red Recording icon will appear on the Recording button.

![Figure 95 – Recording](image)

4. To stop the Recording, press the **Recording** button again.

5. At the **Confirm Recorder Stop** window, press **OK**. This will stop the recording.
Exiting a Collaborate Session

1. At the top of the Blackboard Collaborate window, click on File.

![Figure 96 - Exiting a Session](image)

2. Click Exit (on Mac OS X, click Quit).

   Note: You can also click on the red X in the corner of your window, or use the keyboard shortcut Ctrl+Q to exit.

Accessing Archived Collaborate Sessions

Upon archiving a Collaborate session, you may access the recorded session at any time after the session has ended. Follow the steps below to access an archived session.

1. Log into D2L Brightspace at [http://d2l.kennesaw.edu](http://d2l.kennesaw.edu) and enter your course.
2. From your D2L Course, click Content.

![Figure 97 - Click Content](image)

3. Click the Module that contains the Blackboard Collaborate Session link.
4. In the Module, click Blackboard Collaborate.

![Figure 98 - Live Classroom Link](image)
5. The list of available sessions will appear. Click on **Recordings**.

![Figure 99 - Access Session Recordings](image)

6. A list of all session recordings will appear.

![Figure 100 - List of Recorded Sessions](image)

7. The following icons indicate the types of recordings available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Blackboard Collaborate Format" /></td>
<td>Blackboard Collaborate Format: Will open an archived view of the entire collaborate session. This view shows the entire <em>web conferencing room</em> during the recorded session.</td>
</tr>
<tr>
<td><img src="image" alt="MP3 (Audio) Format" /></td>
<td>MP3 (Audio) Format: Will open an audio only file in a separate window and give you the option to download the file.</td>
</tr>
<tr>
<td><img src="image" alt="MP4 (Video) Format" /></td>
<td>MP4 (Video) Format: Will open a video only file in a separate window and give you the option to download the file. This will only show the view of the whiteboard and will not show you the audio &amp; video, Participants, or chat panels from the archived session.</td>
</tr>
</tbody>
</table>

8. Click on an icon to open the archived session in a new window.

**Note:** You can also click on the title of the session to the right of the icons. A sidebar will open with additional information about the recorded session and access to the archived session in the Blackboard Collaborate Format, MP3 Audio Format (if available), or MP4 Video Format.
Additional Help

For additional support, please contact the KSU Service Desk:

KSU Service Desk for Faculty & Staff

- Phone: 470-578-6999
- Email: service@kennesaw.edu
- Website: http://uits.kennesaw.edu